Accessible Information Guidelines

Making information accessible for people with aphasia
We believe in life after stroke. That's why we support stroke survivors to make the best recovery they can. It's why we campaign for better stroke care. And it's why we fund research into new treatments and ways of preventing stroke.

We're here for you. If you'd like to know more please get in touch.

**Stroke Helpline:** 0303 3033 100  
**Website:** stroke.org.uk  
**Email:** info@stroke.org.uk  
**Textphone:** 18001 0303 3033 100

© Stroke Association, July 2012  

All rights reserved. No part of this publication may be reproduced or transmitted, in any form or by any means, electronic, photocopying or otherwise without prior permission of the publishers. NHS workers and teachers may make photocopies for education purposes only, provided that no charge or profit is made for any course or event for which they are used.

Published by the  
**Stroke Association**  
**Stroke Association House**  
**240 City Road**  
**London EC1V 2PR**

stroke.org.uk
## Contents

Authors and acknowledgements  
Introduction  
The Five Steps  
**Step 1:** A short message  
**Step 2:** Clear sentences  
**Step 3:** Easy words  
**Step 4:** Good layout  
**Step 5:** Make a set  
Checklist  
Word-processing advice  
Further Reading  
Notes
Acknowledgements

We thank all the people with aphasia and their families who contributed to the development of these Guidelines. We are extremely grateful for the time, thought and effort that they put into helping us with this work. Thank you.

We are very grateful to Jon Dale of Transmit Creative for working with us to design the card sets.

Thanks are also due to members of staff at the Stroke Association. Maggie Warburton initiated the project, enabling us to work on the Guidelines and on a related project. Aileen Donald has supported the work from an early stage and continues to provide us with help and guidance. Several members of staff based in Sheffield facilitated our recruitment of people to the project. Finally thanks are also due to the speech and language therapists, and the Stroke Association employees who gave us their opinions of the Guidelines. Thanks to all of you.

Authors

Ruth Herbert,
Department of Human Communication Sciences,
University of Sheffield

Caroline Haw,
Community Intermediate Care Service,
Sheffield Teaching Hospitals NHS Foundation Trust

Catherine Brown,
English Language Teaching Centre,
University of Sheffield

Emma Gregory,
Department of Human Communication Sciences,
University of Sheffield

Shelagh Brumfitt,
Department of Human Communication Sciences,
University of Sheffield
Introduction

The Stroke Association provided the funding for the development of these Guidelines. They are designed for use by people working with people with aphasia. They aim to help people produce written materials, in order to make them more accessible to people with aphasia. We have written these Guidelines in an accessible form in order to demonstrate as far as is possible the kind of written style we are aiming for.

What is aphasia?

- Aphasia can happen after a stroke
- Aphasia affects language
- Aphasia can affect understanding and talking
- Aphasia can affect reading and writing
- Aphasia is different for different people

The need for Guidelines

People with aphasia need information. They need information about the effects of stroke and about aphasia. They need information about life after stroke. Aphasia can make it difficult to make sense of new information. New information is often not accessible to people with aphasia. Making information accessible is a challenge. Health-workers and others need guidelines to help them make information accessible.
Development of these Guidelines

Our research project studied what helps people with aphasia understand information. We looked at the literature on aphasia and accessible information. The references we looked at are on page 28. We consulted people with aphasia in focus groups. They told us what helps them understand information. These Guidelines are a summary of the main points we discussed.

Who are these Guidelines for?

If you work with or know someone with aphasia, these Guidelines are for you. The Guidelines can help to make everyday information accessible. The Guidelines can help to make more complicated information accessible. They are intended to help people with aphasia live their lives, through better information.
What are these Guidelines for?

These Guidelines can be used to make any information accessible. Some examples are:

- Information about services
- Communication resources
- Explanations to people about their condition
- Letters to people with aphasia
- Setting goals with people with aphasia
- Medical information
- Ward notices
- Explanations to people about their care
How to use these Guidelines

• Identify what you want to communicate
• Work from an existing document or start from scratch
• Use these Guidelines to make your information more accessible
• The Guidelines give you advice on the types of words and sentences to use
• The Guidelines give you advice about pictures and layout
• There is advice about the amount of information to include
• The Guidelines assume you are using Microsoft Word on a computer
• You can also use the principles to produce information by hand
The Five Steps

There are Five Steps to follow

Step 1: A short message
Step 2: Clear sentences
Step 3: Easy words
Step 4: Good layout
Step 5: Make a set

There is a checklist on page 23 to help you.

Use the advice on using Microsoft Word on page 24 to produce materials.

There are examples to help you, in shaded boxes.

Blue text shows the issue we are talking about.

Our amended versions follow in bold.
Step 1: A short message

Make sure you have a clear message

• Write your information down
• Cut out anything that is not needed
• Are there several messages?
• Separate the messages out
• Make a list of your messages
• Put them in a logical order

Stroke makes it difficult to move one side of your body, so you may find walking and getting about harder.

Stroke makes one side of the body weak
Your arm may be weak
Your leg may be weak
Walking is difficult

Because a stroke happens suddenly with no warning it can be very frightening.

Stroke happens suddenly
Stroke happens without warning
Stroke is frightening

Working with the messages

• Take the first message, for example, Stroke happens suddenly
• Work with that message, following Steps 2 to 4, which are shown in these Guidelines
• When that message is completed, take the next message, Stroke happens without warning
• Work through Steps 2 to 4 with the second message
• Complete Steps 2 to 4 for all your messages
• This makes a set of related messages
Step 2: Clear sentences

Make your sentence simple

- Think about your sentence
- Simple sentences work best
- Keep it short
- Keep to the point
- Make one point only in a sentence
- Aim for about five words in a sentence

Active is easier than passive

<table>
<thead>
<tr>
<th>Active</th>
<th>Passive</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ambulance will collect you</td>
<td>You will be collected by the ambulance</td>
</tr>
<tr>
<td>The doctor will check you</td>
<td>You will get checked by the doctor</td>
</tr>
<tr>
<td>Your stroke might affect your memory</td>
<td>Your memory might have been affected by your stroke</td>
</tr>
</tbody>
</table>

Pronouns

Pronouns are words such as he, she, it, we, us, they, them, this, that. These words are difficult for people with aphasia.

Council leaflet: We have sheltered housing for people to apply for, and you can get information about this from us.

The council has sheltered housing
You can apply for sheltered housing
You can get information from the council
Complicated sentences

Some sentences are complicated
Some sentences are simple
Try to use simple sentences

If you have found that you can’t concentrate so well take regular rests
If you can’t concentrate take regular rests

You might have found that it’s harder to go out
It might be harder to go out

Too many sentences

Sentences can sit inside other sentences
Separate the sentences

The doctor who you saw last Friday will come and see you on Wednesday
You saw the doctor last Friday
You will see the same doctor on Wednesday
Check the reading level of your sentence

- Microsoft Word can check the readability of sentences
- Readability is a measure of how hard a sentence is to follow
- It is graded from 0, which is easy, to high such as 20, which is very difficult
- For people with aphasia we are aiming for a score of 5 or lower

- Use Flesch-Kincaid to check readability
- You need to add a full-stop at the end of your sentence
- This allows the software to read the sentence
- Go to page 24 for how to set up Flesch-Kincaid

- Use **Flesch-Kincaid**
- Check the **Grade Level**
- Check you have a number of 5 or lower
- If the number is 6 or higher, you need to make your sentence simpler
Step 3: Easy words

Use everyday words

- Choose your words carefully
- Choose words people use often
- Choose words most people use
- Use everyday words
- Use meaningful words
- Use whole words

<table>
<thead>
<tr>
<th>Easier words</th>
<th>Harder words</th>
</tr>
</thead>
<tbody>
<tr>
<td>stroke</td>
<td>CVA</td>
</tr>
<tr>
<td>medicine or tablets</td>
<td>medication</td>
</tr>
<tr>
<td>get better</td>
<td>recover</td>
</tr>
<tr>
<td>interest</td>
<td>motivation</td>
</tr>
<tr>
<td>doctor</td>
<td>physician</td>
</tr>
<tr>
<td>cope with</td>
<td>compensate for</td>
</tr>
<tr>
<td>ambulance</td>
<td>transport</td>
</tr>
</tbody>
</table>

Easier words

The **physician** will **assess your condition** before **prescribing medication**
The doctor will check you
The doctor will give you tablets

A **CVA** can be **haemorrhagic** or **ischaemic**
A brain bleed causes a stroke
A blood clot causes a stroke
Step 4: Good layout

Create a space for your message

- You need lots of white space around your message
- Postcard size is good if using paper
- For typing, half of A4 works well
- A5 works well
- Make a box for your message
- We recommend you insert one cell by using Insert Table in Word

(This is where you write your message)

- Make a border for this box
- Choose a simple border
- Go to page 26 for advice on inserting tables and borders
**Typing and fonts**

- Type your sentence top left
- Leave plenty of space around the text
- Use a font size between **14** and **18** pt
- Use a sans serif font
- Arial and Calibri are sans serif and easy to read
- Times New Roman is serif and is harder to read

---

**Gestures** can help

---

- Use sentence case - a capital letter in the first word only
- Make important information bold
- Make important information two font sizes bigger
- Don’t underline any of the text
Headings

- Headings can help
- Use headings to organise information
- Use coloured headings
- Make the heading two font sizes larger

**Aphasia**

*Pointing* can help
Pictures

- Choose one or two pictures
- Use clear pictures
- Choose good quality pictures
- Use either line drawings or photos
- Pictures made for adults work best

Aphasia

Pointing can help

A good picture

This picture shows the meaning of the sentence
It is clear
It is adult
Linking writing and pictures

- Put the picture under the sentence
- Check the picture matches the important information exactly
- Use a new picture for new information
- Use two pictures if you need to
- Use a new picture for each new concept

![Picture Example](image)

A good picture for the message

The people look right – adult and old enough
The picture shows the activity
The picture matches the words
Use of colour

- Use white paper
- Use dark writing
- Use colour in pictures to help with the meaning
- Use colour in headings to help organise information
- Use colour in borders

Driving after stroke

A blue badge can help

Colour

Blue is an important part of the badge
Colour can help organise the information
The heading and border are blue
Step 5: Make a set

Make a set of messages

• Go back to Step 1
• Take the next message from your list
• Repeat Steps 2 to 4 with each message

Be consistent

• Use the same layout for each message
• Use the same font
• Use the same colour
• Use the same style of pictures

Repetition helps

• Repetition helps people with aphasia
• Repeat important words or phrases

Clear sets

• Use the same colour border for all messages in one set
• Use the same colour writing for all messages in one set
• Use numbers to show the order of messages in a set

Amount

• About five to ten messages make a good set
• Most people with aphasia prefer to see one message at a time
• Each message should be presented on its own

See the examples on the next page.
language

Language is talking and understanding

“hello”

language

Language is reading and writing

Reading and writing
Checklist

• Messages are short □
• The order of the messages is logical □

• The sentences are simple □
• The words are everyday words □

• The space is A5 or a postcard □
• There is one box for each message □
• There is a simple border around each box □

• The writing is in the top left □
• The writing is 14pt or larger □
• The font is sans serif - Arial or Calibri □
• Important words are in bold larger type □

• There is one heading for each set of messages □
• The heading is in larger font □

• Colour shows meaning clearly □
• Colour shows which messages are together □

• There are one or two good quality pictures □
• The pictures are clear and adult □
• The writing and pictures match in meaning □
• The pictures are of the same style □

• The set has the same layout throughout □
Word-processing advice

If you are using Word 2007 or 2010
• Click on the Review tab
• Click on Spelling and Grammar
• Click on Options
• Tick Show readability statistics
• Click on OK

OR
• Click on the File tab
• Click on Options
• Click on Proofing
• Tick Show readability statistics
• Click on OK

THEN
• Complete the Spelling and Grammar check
• A table appears
• Look at Flesch-Kincaid Grade Level
• Low numbers mean your text is simple to read (0 to 5)
• High numbers mean your text is hard to read (6 upwards)
If you are using Word 2003

• Click on the View tab
• Select Toolbars
• Click on Review to activate that Toolbar
• Click on Grammar and Spelling
• Follow steps above from Options onwards

For all users

• Flesch-Kincaid is now set up
• Next time, just click on Spelling and Grammar
• Remember to add a full-stop at the end of the sentence you want to check
• Run through the spell and grammar check
• Click ok when asked if check is complete
• The readability table will appear
• The Grade Level is the bottom line
To make a box using Word
• Go to Insert Table
• Select a table that is one row x one column
• Make the box longer by putting the cursor in the box and pressing the Enter key as many times as you need

To put a border around a box
• Highlight the whole box
• Right click on the box while it is highlighted and select Borders and shading
• Click on the Page Border tab
• In Style select a simple border
To add a picture
- Position the cursor in the box
- Click on the **Insert** tab (top of taskbar)
- Select **Picture**
- Browse your PC to find the picture you want
- Click on the picture
- Click on **Insert**
- The picture will appear in your document

To edit a picture in your document
- Click on the picture to highlight it - a border will appear around it
- Click on the **Text Centre** button to move the picture to the centre of the box
- Click on one of the buttons in the border around the picture
- Drag the button to make the picture wider, longer, or larger or smaller

Need more help with Word?
Go to the Word: help and how-to section of Microsoft’s website at http://office.microsoft.com/en-us/word-help/
Further Reading


One in three people who survive a stroke will be left with aphasia. Aphasia is a largely hidden disability which can seriously affect a person’s ability to speak, read, write and communicate.

These guidelines have been developed as part of a research project commissioned by the Stroke Association to find out what helps people with aphasia to understand information. If you work with or know someone with aphasia, these Guidelines will help you to make everyday information more accessible.

Stroke Helpline: 0303 3033 100
Website: stroke.org.uk
Email: info@stroke.org.uk
Textphone: 18001 0303 3033 100

© Stroke Association, July 2012
Price £7.50